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Preface 

About this Document 

 This document provides the information necessary to operate the 

Advisor system. 

Notes and Warnings 

The following note is used in this document. 

NOTE 

This is an example of a note. 

Related Documents 

Document Description 

Advisor Administrator Guide This document describes how to configure 

Advisor. 

Important Safety Information 

Laser Description and Class 

The Advisor is a class 1 laser system and contains two laser assemblies for 

mapping and marking.  

Marking Laser 

DiaMark: wavelength 1064nm, max power 80mw, class 4 

DiaMark-Z: wavelength 1064nm, max power 1w, class 4 

Mapping Laser 

Wavelength 600-700nm, max power <1mw, class 2 

NOTE 

Exposure to the beam of a Class 1 laser will not result in eye injury 

and may therefore be considered safe.  

However because this class 1 system contains laser systems of a 

higher class it is vitally important that the machine is NOT operated 

with any of the protective doors, covers, hoods or windows open.  
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Laser Safety 

We at Sarin recommend that you provide laser safety training to all 

employees who work on or around the laser system. It is important that 

they understand the bio-effects of lasers as well as the facts about laser-

radiation. 

System installation, disassembly, maintenance and repair must only be 

performed by authorized Sarin customer support engineers. Sarin trained 

engineers are trained to comply with all applicable safety requirements 

regarding the use of laser devices at the customer’s premises. 

NOTE 

The Sarin warranty becomes null and void if servicing of the system 

is undertaken by a third party. 

What is a Laser Class? 
Laser products are classified to take account of the amount of laser beam 

you can get access to when the product is in normal use or during routine 

user maintenance. A laser product may contain a laser of a higher Class 

and this may be accessible during servicing.  

A brief description of each laser Class can be found at: 

http://www.hpa.org.uk/radiation/faq/laser/laser9.htm 

Waste Electrical and Electronic Equipment (WEEE) 

Disposal of Electrical and Electronic Waste 

The symbol  is now displayed on Sarin products to show our compliance 

with directive WEEE. The WEEE directive is about recycling parts and states 

that no electrical or electronic equipment can be discarded into the city’s 

normal waste disposal system.  

Obligatory Acceptance of Discarded Electrical and 
Electronic Equipment 
The end user of this product now has the right to request the product 

supplier to dispose of the product. Therefore, if you require help in 

discarding this product please contact your local agent or Sarin directly.  

http://www.hpa.org.uk/radiation/faq/laser/laser9.htm
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How to Contact Us 

Please contact your local Sarin representative with any questions or 

comments you may have regarding the site preparation procedure. 

Headquarters: 

Sarin Technologies Ltd. 

4 Hahilazon Street 

Ramat Gan 52522 

ISRAEL 

TEL: +972-(0) 3 7515490 

FAX: +972-(0) 3 7515485 

 

General Information: 

Info@sarin.com 

Support 

TEL: +972-(0)-3 751 9271  

TEL: +972-(0)-3 7515490 EXT 111  

support@sarin.com 

Website: 

www.sarin.com 

mailto:Info@sarin.com
http://www.sarin.com/
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INTRODUCTION 

Advisor is a unique system designed to calculate optimally proportioned 

shapes in rough diamonds, for maximum yield. By combining computerized 

machine vision and advanced 3-dimensional image processing, Advisor 

accurately forecasts the best proportions of a final stone for all commercial 

shapes. In effect, Advisor is a decision support tool which assists the 

diamond cutter in the most crucial step of diamond processing – cutting the 

rough diamond while achieving the maximum yield possible, calculating 

millions of cutting options in seconds. Advisor takes into consideration 

different shape possibilities, proportions and internal flaws and provides the 

optimal solutions. Advisor maps grooves, holes, and other concave areas 

on the rough surface, enabling users to analyze complicated stones in a 

way not possible before. 

This manual describes the system settings required to configure Advisor. 

You can contact us through your local dealer or simply visit our website at: 

www.sarin.com 

http://www.sarin.com/
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What’s New in Release 2.0 

Feature Description See 

Best Value 

Feature 
Greatly 
Improved 

Advanced algorithms will automatically decide which solution 

is more profitable while taking into account different shapes, 
cut grades and inclusions clarity and location. The solution is 
based on the price tables that can be customized according 
to your company pricing policy. 

See User Guide. 

Multiple stone 
planning 

Now you can simply and quickly plan more than two stones 
out of the same rough. This feature enables you to 
simultaneously divide the stone into as many parts as you 
want and then plan each part separately. 

See User Guide. 

Remainder 
Advisor 

Planning multiple remainder planes (tops) is simple with the 
new remainder function. The system can even suggest the 
best tops to be removed. 

Remainder 
Options  
on page 9. 

Advanced 
Inclusion 

mapping 

This revolutionary function enables you to accurately plot 
inclusions. The software automatically calculates the position 

and clarity of the inclusion according to the position of the 
inclusion as viewed by the user. 

See User Guide. 

Bottom saddle 

mapping 

Advisor can now map stones with a high precision that have 

bottom saddles. 

See User Guide. 

Marking 

improvements 

Marking options have been expanded. 

 Control the size of table and culet cross 

 Marking of the center girdle line 

 Separate control of width and velocity for each 
type of marking 

 Table and culet marking parameters have been 
separated for more flexibility 

 Multiple saw planes can be marked 
simultaneously 

See User Guide. 

Manufacturing 

Stages 

Enables you to visualize the upcoming stages in the 

manufacturing process. 

See User Guide. 

Pricing 

Discount 

use this feature to create your own discount table below the 

official list price. 

See User Guide. 

Default Saw 

Thickness 

use this to automatically calculate the required thickness of 

the saw plane according to the rough part weight. The 
ranges can be customized according to your needs. 

Default Saw 

Thickness  
on page 10. 

Pricing 
Calculator 

this small tool enables you to quickly calculate the price of 
different planning possibilities before even starting to plan 

the stone. 

See User Guide. 

Report 
improvements 

now you can select from a wide range of available reports 
and labels (including designing your own). All angles for all 
shapes can now be used in views, labels and reports. 

See User Guide. 

Export all 
Results 

All planned results can now be exported simultaneously and 
automatically. 

See User Guide. 

Cut grade 
order 

Changing the display order of the cut grades is now 
possible. 

Cut Grade on 
page 28. 

Additional 
data display 

A large number of new data fields have been added so that 
all angles for all shapes can now be displayed 
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Feature Description See 

Forced 

Allocation 

You can control the restrictions on the forced allocations in 

all three axes enabling you to define both the direction and 
position of the final allocation. 

 

Laser Safety 

Export 
distance 

Enables you to set the safety distance to the requirements 

of the external cutting equipment. For example the Quazer. 

Laser Safety 

Export Distance 

on page 13. 

Password 
protection 

You can now safeguard your production line by prohibiting 
anyone from changing the Proportion information using a 
password. The password protects the proportions, pricing 
tables, planning and marking options. 

Password 

Protection on 
page 8. 

New File 

Types 

Sarin have added a new file type (*.cap) that includes all 

the video images when saving your data. 

New File Types 

below. 

Stone 
Properties 

The Stone Properties window now contains more 
information. 

See User Guide. 

Improved 
Mapping 

The mapping is not only more accurate but you can now 
select the different levels of accuracies. 

See User Guide. 

Selectable 
Mark-up and 

Discounting 

You can make a selectable discount or markup using the 
Discount option for a combination of grading system, cut 

grade and weight range. 

See User Guide. 

Select Report 

and Label 
Feature 

Right-click the report or label buttons to select different 

types of reports and labels. 

See User Guide. 

New File Types 
Before version 2.0 you could only save your stone information files in the 

*.stn format. Sarin have now added the new *.cap format that also 

includes all the video images. This means that when loading *.cap files the 

video viewer is now enabled even though you are not connected to the 

hardware. 

Using the Help File 
To display the built-in Help file do one of the following: 

 Click the ? button 

 Press the F1 key on the computer keyboard 

 From the Help menu, choose Sarin Advisor Help 
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CONFIGURATION TAB OPTIONS 

The Option configuration window is divided into multiple tabs for pre-

defining the option parameters. These are global parameters affecting the 

whole system. 

These options tabs pre-define the following: 

 General system options 

 Planes parameters 

 Export parameters 

 Parameters for configuring the different printers 

 Planning options 

 Price list parameters 

Your Advisor package has been shipped to you with pre-defined settings 

that can be changed to better serve your measuring and evaluation 

requirements. 

General Tab 
The General tab provides the parameters for configuring the general 

Advisor parameters.   

 To open the General tab (default tab): 

 Click the  button the General tab opens by default. 
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After Mapping  

These configured values are activated as soon as the mapping is 

completed. 

Open stone properties dialog 

When checked, the stone properties dialog box is opened automatically as 

soon as the mapping is completed. 

Automatically name stone 

Stones are named automatically.  

Type a batch name in the Name field (e.g. “MyStone”) and enter a starting 

Index number (e.g. “1”). Each time an additional stone is measured the 

new name becomes the contents of the Name field plus the Index+1. This 

is especially useful when you want to automatically export the stone data 

without having to type a name for each stone you measure. 

Change Color/Clarity  

This pane controls whether or not any changes made to either the color or 

clarity inside a program results are reflected in all the other results or not. 

Item Description 

Yes Changing either the color or clarity values in any of the program results 
will reflect this change in all the other results. 

No Changing either the color or clarity values in any of the results dies NOT 

reflect this change in any of the other results. 

Ask Changing either the color or clarity values in any of the results opens a 

window to ask if you want to force either of the two parameters 
described above. The Ask window has a checkbox you can select to 
make your selection permanent. 

Marking Selections 

Select this check box if you want to reset the marking selection every time 

you open the Mark tab. 

Polish Weight 

Select this check box if you want to enable the ability to change the polish 

weight manually. 

Automatically Saving Stone Data 

If configured you can save the current stone file automatically when: 

 Closing the software 

 When starting to measuring a new stone 
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 To use the automatic save feature: 

1. On the top right-hand side of the window, click the  button to open 

Options window.  

 

 

2. In the Automatically Save Stone pane select the Save Stones in this 

package check box. 

3. Click the   button to select the package where you want to 

automatically save the stones. 

4. Click OK. 

 To use the automatic file deletion feature: 

This feature automatically deletes all files in the displayed package after 

the selected number of days. 

1. In the Automatically Save Stone pane select the Number of days to 

keep stones check box. 

 

 

2. Either type a new number in the Number of days to keep stones 

box, or use the arrow buttons to change the value. 

 

In this example all files older than 10 days are automatically deleted 

from the displayed package. 

3. Click OK. 

User Name 

You can choose either a default name or request a Log-on name every time 

the program is opened. 

 To create a default name: 

1. Select the Name check box. 

 

 

2. Type your name in the Name field. 

3. Click OK. 
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 To create a log-on name: 

1. Select the Use Log-On Name check box. 

 

 

2. Click OK. 

3. Close the Advisor program and then open it again. 

 

 
 

The Log-On window opens displaying the name of the last person that 

Logged-On. 

4. Update the name if required. 

5. Click OK. 

Mapping Method  

The Mapping Section offers options for mapping rough stones. The default 

is Accurate as this is suitable for most stones. Before mapping complex 

stones, however, select the Most Accurate option and then perform the 

mapping. Under this option, the mapping is slower but captures small but 

maybe relevant details. After mapping a rough stone with the Most 

Accurate option, do not forget to restore the setting to Accurate or Regular.  

Interactive 

When selected a full allocation is performed each time the saw line is saved 

in interactive mode. 

Measurement Units  

Choose either MOE or mm (millimeter) as the measurement unit for the 

length, width and height of the stone.  

The caliber tool also uses the unit selected here. 
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Password Protection 

You can prevent unauthorized personnel from changing the data fields in 

the four tables and options listed below: 

 Proportion tables 

 Pricing tables 

 Planning options 

 Marking options 

 To use a password: 

1. Click the  button. 

 

 

2. Enter the old password or leave the field blank if there is no password. 

3. Enter a new password and then confirm it in the field below. 

4. Select the checkbox corresponding the function you want to protect. 

 

You can protect the four specific functions independently. 

5. Click the  button to close the window. 

6. Click the  to save your data and exit the Options screen. 
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Planes Tab 
 To open the planes tab 

Click the Options  button and then click the Planes tab. 

 

 

Remainder Options 

1. On the top right-hand side of the window, click the  button to open 

Options window.  

2. Click the Planes tab. 

3. Enter a value for the Remainder Safety Distance or leave blank. 

4. Enter a number for the Amount of Automatic Remainders. 

 

When planning and using the automatic option this number limits the 

number of remainders created. 

5. Click the  button to save your data and exit the Options 

screen. 
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Default Saw Thickness 

This enables you to create saw thicknesses based on the rough weight of 

the stone. 

1. In the Planes tab, Default Saw Thickness pane. 

 

 
 

The initial values are shown above (not a default). You can edit any of 

the rows but we recommend that you only edit the last three empty 

rows. If you edit the first four rows they do not revert back to the 

initial values when reopening the Advisor. 

2. In the left-hand column, enter a weight (ct.). 

3. In the right-hand column, enter a percentage (accepts single digits). 

4. Select the Activate default saw thickness check box to enable it. 

5. Click the  button to save your data and exit the Options 

screen. 
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Export Tab 
The Export tab provides the parameters for automating the results export 

procedure.  

 To open the export tab: 

 Click the Options  button and then click the Export tab. 

 

 

Output Files Pane 

Ask 

If you select this parameter, Advisor always asks you to specify the name 

of the export file. 

Name 

Select this parameter to pre-define the names of export files. After 

providing an initial name, Advisor generates names automatically each 

time you export results (or appends results to the same file). In the Name 

box, type an initial name, such as export.txt. 
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There are three Parameters: 

Parameter Description 

Append Mode If checked, Advisor creates one file and adds results to 

that file every time you export data. 

Indexed If checked, Advisor creates a new file every time you 

perform an export operation. It generates a file name 
consisting of the string you entered in Name and a 
sequential number. For example: export1.txt, 
export2.txt. 

Name Index Used with the Index parameter. Type the starting 
number of the filename index. For example, if you 
enter 10, the first export operation creates a file that 

carries a name such as export10.txt, the second is 

named export11.txt, and so on. 

Stone Name + Extension 
Takes the name from the Stone Properties box and adds the file extension 

that is displayed here. The default is txt. 

Destination Path 

Type the disk directory where you want Advisor to store export files, or 

click the browsing button to select the directory. 

Source Template  

Ask 

If you select this parameter, Advisor always asks you to select an export 

template. 

For details on templates, see Planning Options Tab on page 14. 

Name 
If you select this parameter, Advisor always uses the same export 

template. Select the name in the list. 

For Each Shape Which Template 

This option allows you to instruct Advisor to create a separate export file 

for each shape. Follow these steps: 

1. From the list, click a shape. 

2. Select Ask, if you want Advisor to ask you to select a template every 

time you perform an export operation.  

 

If you want to instruct Advisor to select a template automatically, 

select Name and then select a template. 

3. Repeat this step for each shape. 
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When  

After Measure 

If you check this option, Advisor performs the export operation 

automatically (as if you clicked the Export icon) after completing a 

measurement. 

After Planning 

If you check this option, Advisor performs the export operation 

automatically (as if you clicked the Export icon) after planning. 

Export Options 

You can decide to export either only selected results or ALL the results. 

Laser Safety Export Distance  

If you are working with laser cutters like the Sarin Quazer you can 

incorporate into the planning a safety distance. This enables you to tailor 

the value to suit the laser you intend to use to cut the stones. 

Printers Tab 
You can assign a different printer and change orientation, size, and 

margins locally for each of the following groups: Current view and 

Display, Reports and Labels. These settings do not affect other programs 

and are saved automatically. 

 To open the printers tab: 

 Click the Options  button and then click the Printers tab. 

 

 
 

This shows the Views and Report printers. 
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 This shows the Label printers. 

 

 

NOTE 

When clicking the Results  print icon in Advisor, the print dialog 

box is automatically opened for you to change the parameters if 

required. You cannot predefine these parameters in this tab. 

Planning Options Tab 
The Planning Options tab provides the parameters for creating program 

templates and parameters for configuring forced planning.  

 To open the printers tab: 

 Click the Options  button and then click the Planning Options tab. 
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Planning Templates 

Planning programs perform one or more plans automatically. Advisor 

allocates a stone (calculates the best possible final cut) according to an 

institute, a shape, a cut grade, and a tilt value. Therefore, you will define 

planning programs by setting these four parameters for each plan. 

A program may perform more than one plan. For example, you can build a 

program that plans a stone under the same institute, shape, and tilt angle 

but for different cut grades. This program would perform automatically and 

successively as many plans as the number of cut grades defined for the 

institute, shape combination, and would create just as many entries in the 

results table. Usually, you will build programs to perform a series of plans 

automatically, instead of selecting tilt, institute, shape, and grade 

parameters (in the Plan window) for each plan separately. 

Creating a New Program Template 

 To create a new program template: 

1. Click the Options  button and then click the planning options 

tab. 

2. Select the Program radio button. 

3. Click the Add button next to the Name field, and then enter a unique 

Program template name. 

4. At the bottom of the Plan display window, choose a parameter from 

each of the following dialog boxes: 

 Shape 

 Institute 

 Grade 

 Tilt 

5. At the bottom of the Planning Templates pane, click the Add button. 

 

A new plan is now displayed in the Plan display window. 

6. Repeat steps 4 and 5 to add more plans to the current program. 

7. Click OK to save the planning template and close the window. 

Deleting a Program Template 

 To delete a program template: 

1. Click the Options  button and then click the planning options 

tab. 

2. Select the Program radio button. 

3. Select the program you want to delete. 

4. Click the Delete button next to the Name field. 
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Deleting a Plan from a Program Template 

 To delete a plan from a program template: 

1. Click the Options  button and then click the planning options 

tab. 

1. Select the Program radio button. 

2. In the Name field select the program name that contains the plan you 

want to delete. 

 

The plans for this program are displayed in the Plan window. 

3. Select the plan you want to delete. 

4. At the bottom of the Planning Templates pane, click the Delete 

button. 

 

The selected plan is now deleted. 

5. Click OK to save the changes and close the window. 

Creating a New Best Value Template 

 To create a new best value template: 

1. Click the Options  icon to open the Options window. 

2. Click the planning options tab. 

3. Select the Best Value radio button. 

4. Click the Add button next to the Name field, and then enter a unique 

Best Value template name. 

5. At the bottom of the Plan display window, choose a parameter from 

each of the following dialog boxes: 

 Shape 

 Institute 

 Grade 

 Price 

6. At the bottom of the Planning Templates pane, click the Add button. 

 

A new Best Plan is now displayed in the Plan display window. 

7. Repeat steps 4 and 5 to add 2 plans to the current program. 

8. Click OK to save the planning template and close the window. 



Advisor - Administrator Guide Configuration Tab Options 

 

©Sarin Technologies Ltd. 2000-2006. All rights reserved. 17 

Deleting a Program Template 

 To delete a program template: 

1. Click the Options  icon to open the Options window. 

2. Click the planning options tab. 

3. Select the Best Value radio button. 

4. Select the Best Plan you want to delete. 

5. Click the Delete button next to the Name field. 

Deleting a Plan from a Program Template 

 To delete a plan from a program template: 

1. Click the Options  icon to open the Options window. 

2. Click the planning options tab. 

3. Select the Best Value radio button. 

4. In the Name field select the Best Value program that contains the 

plan you want to delete. 

 

The plans for this program are displayed in the Plan window. 

5. Select the plan you want to delete. 

6. At the bottom of the Planning Templates pane, click the Delete 

button. 

 

The selected plan is now deleted. 

7. Click OK to save the changes and close the window. 

Forced Planning  

There are two levels of forced planning, namely High and Low. When 

Advisor is put into Forced Planning mode the Manual/Program menu 

becomes the High/Low selector. The forced planning parameters are shown 

below. 

 

Once you have selected a new value it will remain the default each time 

you open Advisor. 

The Forced Planning pane is for setting the restriction parameter values 

to be used for both Part A and Part B planning.  
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Flip Table <-> Culet Tolerance 

This feature is only available when using one plan.  

Flipping generates a new plan with Advisor seeking an optimal flip of 

approximately 180 degrees plus or minus a few degrees. The actual value 

depending on the tolerance value defined here. When flipping the planning, 

Advisor explores the possibilities within the tolerance range. 

 To specify a flipping tolerance: 

1. Click the Options  icon to open the Options window. 

2. Click the Planning Options tab. 

3. In the Flip Table <-> Culet pane enter a value (0-18). 

 

The value is in degrees and set the flip tolerance. For example, enter 

10 to allow Advisor to seek an optimal allocation between 170 and 190 

degrees. 

Price Lists Tab 
A price list sets the price of polished diamonds of different weights 

according to their color and clarity levels. 

Price lists are used in the results list where Advisor enables you to calculate 

the price of the stone. 

 To open the price lists tab: 

 Click the Options  button and then click the Price Lists tab. 

 

Creating a New Price List 

To create a new price list, you must define the weight ranges and set the 

price for each range according to the different colors and clarity levels. 
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 To create a new price list: 

1. From the Price Lists tab, click the New Price List button.  

 

 
 

The Color/Clarity name list window opens. 

2. Choose a Color/Clarity naming standard from the list. 

 

Advisor assigns a default name to the price list.  

The new price list uses the color/clarity names of the selected 

evaluator. 

3. In Shape, select the shape for which you want to define prices. 

4. Next, you need to define the weight ranges so you can record prices 

for different ranges. Click the New Weight Range button.  

 

Advisor automatically defines the first range of carat weights. If you 

want to change the range, you can type a different one in the From 

and To boxes. Also Advisor builds a new Pricing table in the lower 

pane. 

  

You can repeat this step for all the ranges you want to define. 

5. After defining all the ranges, open the Weight Range list and select 

the first range. 

 

The Color/Clarity table now lists the relevant color and clarity units.  

6. In Prices, in the lower half of the dialog box, click a cell and type a 

price for each color/clarity combination. 

 

If you defined your own proportion tables and entered a price factor for 

different cut grades, Advisor automatically multiplies this price with 

Price Factor, according to the stone’s cut grade. 

7. Open the Weight Range list, select the next range, and type in the 

price for each color/clarity.  

 

Repeat this step for all the weight ranges.  

8. After entering the prices for all ranges, select another shape, create 

the ranges, and record the prices for all the ranges of that shape. 

Repeat this step for all the different shapes. 

NOTE 

It is strongly recommended that you copy a price list and then 
correct the values to better suit your needs. 
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Exporting a Price List 

Advisor enables you to export a price list to a special file that can be 

imported into another Advisor system. The file can also be opened in 

Microsoft Excel (the file contains comma-separated values and carries the 

extension .csv. List .csv files after activating the File-Open command in 

Excel). This function is especially useful for sending price lists to Advisor 

users in other sites. 

 To export a price list: 

1. From the Price Lists tab, select the price list you want to export from 

the Select pricing list box. 

2. Click the Export Price List button. 

3. Select the location where you want to save the exported file and enter 

a name. 

4. Click Save. 

 

Advisor adds the extension (.csv) automatically to the exported file. 

Importing a Price List 

You can import into your Advisor system a: 

 Standard price list such as the Rapaport price list 

 Price list exported from another Advisor installation 

 Price list created in Excel and saved as a .cvs file 

When using an Excel file, you must be very careful to record the data 

correctly. The best way to learn the structure of a file is to examine, in 

Excel, a price list exported from Advisor. 

 To import a price list: 

1. From the Price Lists tab, click the Import Price List button. 

2. Double-click the file you want to import. 

3. Select the Color/Clarity naming standard from the list, and then click 

OK. 

 

The new price list is added and named automatically. 
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Copying a Price List 

You can copy a price list from any shape in any institute to another shape 

in another institute: 

 To copy a price list: 

1. From the Price Lists tab, click the Copy Price List button. 

 

 

2. Choose a source Price List and Shape. 

3. Choose a destination Price List and Shape. 

4. Click Copy to complete the operation. 

Setting the Discount Prices 

It is important to remember that each discount list is specific to a 

combination of grading system, cut grade and weight range. 

You can set discount price lists by combining or splitting colors and clarity 

levels. For example, if the price list uses the D-Z color standard, you can 

combine the color grades D, E, and F to a single color range, D-F, and set 

the price for that range (the same price would apply to all of the tree 

colors). The same applies to combining clarity levels.  

You can also split a combined definition into its components. For example, 

if you combined colors to D-F, splitting re-creates the separate D, E and F 

entries. 
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 To group column data: 

1. Select the first column (clarity levels) to be included in the group and 

drag the mouse to the last column you want included in the group.  

The following figures illustrate selected rows and columns. 

 

 
 

The VVS1 and VVS2 and the VS1 columns have been selected. 

2. In the Edit Discount Ranges pane, click the  button.  

 

If prices have been recorded, the group takes the price from the first 

column. 

 

 
 

The three columns are now grouped together as shown above. 

 To group row data: 

This is similar to the previous examples only now we are grouping the 

rows. 

 To split grouped colors or clarity levels: 

1. Click the grouped row or column. 

2. Click the  button.  

 

If prices have been recorded, all individual rows and columns take the 

price of the group. 
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Updating Prices 

You can always select a price list in Pricing Table, and change the prices 

manually for different shapes, weight ranges, and color/clarity pairs. In 

addition, Advisor provides a special tool designed to update prices globally, 

for each range, or for each shape (all of its weight ranges) or for each price 

list (all shapes and all of their ranges). 

 To update prices globally: 

1. Open the Price Lists tab. 

2. Open the Weight Range selection box. 

 

 

3. Select a weight range. 

4. In the Basic Price pane Color/Clarity table, select either a group of 

rows (Color) or columns (Clarity) as shown below. 

 

 

5. Do one of the following: 

a) To update all the prices included in a price list, click the name of 

the list. 

b) To update all the prices for a specific shape, click the   button 

located to the left of the name of the price list. This expands the 

tree to show the shapes of the price list. Then, click the shape you 

want to update. 
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c) To update all the prices for a certain range, expand the price list 

tree to display the shapes and then expand (click ) the shape to 

show its ranges. Then, click a range. The following figure 

illustrates a fully expanded shape branch and a selected weight 

range: 

 

You can click  to collapse a branch. 

6. In the boxes on the right, type the amount (money) by which you want 

to update the prices. 

7. Select the option that defines the update operation. For example, if 

you click Add, Advisor adds the amount to all of the selected prices. 

8. Press the Apply button to complete the operation. 

9. Click OK to close the window.  

 

Advisor now displays the updated prices. 

Setting Markup and Discounts for selected Stones 

 To make a selected discount or markup: 

1. Click the  button to open the Options screen. 

2. Click the Price Lists tab. 

3. Make a discount setting as shown below. 

 

 
 

In the example above we have two examples. 

a) Stones using the HRD grading system, a color  

of D, clarity of VS2 and within the 3.00 to 4.00 ct. weight range 

have a 25% price mark-up (+25.00). 
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b) Stones using the HRD grading system, a color  

of D, clarity of IF and within the 3.00 to 4.00 ct. weight range 

have a 25% price discount (-25.00). 

4. Open the Results tab. 

 

 
 

As you can see the stone we planned meets these requirements 

exactly and therefore shows a mark-up of 25%. 

5. To remove the mark-up, click on the price ($21,210). 

 

 

6. Click the 0% entry. 

 

 
 

The true price is now shown as $16,968, without any mark-up (0%).  
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DEFINING THE STANDARD PROPORTIONS 

This section describes how to define the standard proportions for Advisor 

using the Standard Proportions Editor. Advisor uses a pre-defined set of 

standard diamond proportions when it plans the final stone.  

 To open the proportions editor: 

1. Click anywhere in the Planning parameters pane. 

2. Choose Edit Proportions. 

 

 

Grading System 

Name your set of values here. The set can be named after an actual 

grading system (Institute) or you can make your own set any name you 

want. The names of the grading systems defined here are displayed in the 

Grading System pane. After defining a new grading system, its name 

becomes available for selection in the planning process.  

Button Description 

New The New button creates a new grading system without any 
parameters 

Delete The Delete button deletes the selected user defined grading system. 

Copy The Copy button copies the selected grading system together with 
all the parameters (enabling you to change them) under a new 
unique name. 

Import Proportion tables can be imported from a file. The file must have an 
extension of .ins. 

Export Proportion tables can be exported to a file and loaded into another 
Export system. The file has an extension of .ins. 
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 To export a grading system as a file: 

The proportions you have defined can be exported to back up your data 

and also transfer the exported grading system to another Advisor system. 

1. In the Grading System pane, select the grading system whose data 

you want to export. 

2. Click the Export. 

3. Select the folder where you want to save the file and enter a name. 

For the exported file, Advisor adds the extension automatically. 

 To import Advisor proportions as an external file: 

You can import a previously exported grading system file. 

1. In the Grading System pane, click Import. 

2. Change to the folder where the file is located and double-click it.  

3. Advisor imports the values under a new institute name.  

 

Right-click the imported grading system and choose Rename from the 

popup menu to rename it. 

 To rename a grading system: 

1. Click anywhere in the Grading System pane. 

 

The menu is displayed. 

2. Choose Rename. 

 

 
 

The Rename Grading System window opens. 

3. Change the name. 

4. Click OK. 

Shape 

Advisor is installed with built-in shapes and enables you to import 

additional shapes from www.gemcad.com the GemCad site. Once imported, 

the shape becomes available for selection in different drop-down lists as 

any other shape (for example, when planning) throughout Advisor. 

 To import a user-defined shape: 

1. Click the New button. 

 

The standard Open dialog box opens. 

http://www.gemcad.com/
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2. Find and select the GemCad file ( .asc file) and click the Open button. 

 

 
 

The New Shape Name dialog box opens. It contains the name of the 

file you have just selected (without the extension). 

3. You can type a different name. 

 

Use a name that is intuitive and that you would like to see as a shape 

name on the selection lists throughout Advisor. 

4. Click OK. 

 

The new name is displayed on the list in the Shape pane and in all 

other selection lists throughout the system. 

 To delete a shape: 

1. Select the shape you want to delete. 

2. Click the Delete button. 

NOTE 

You can only delete user created shapes. 

Cut Grade 

Although grades (Excellent, Good, etc.) are standardized, you can give any 

name to any grade. The names you define here appear in the cut grade 

drop-down list in the Planning window, when you select the institute to 

which they belong. You can drag the entries into a new position in the list. 

This means that you can have the list display the cut grade entries in any 

order you desire. 

Item Description 

New Creates a Cut Grade without any parameters. 

Delete Deletes the selected Cut Grade. 

Copy Copies the selected Cut Grade together with all the parameters 

(enabling you to change them) under a new unique name. 
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 To rename a cut grade: 

1. Click anywhere in the Cut Grade pane. 

 

The menu is displayed. 

2. Choose Rename. 

 

 
 

The Rename Cut Grade window opens. 

3. Change the name. 

4. Click OK. 

Price Factor 

When pricing a stone, Advisor multiples the calculated price with this 

factor. To increase the price, type a percentage above 100. For example, if 

the price of an Excellent stone is to be automatically increased by 10%, 

type 110. 

Standard Size Planning 

For each grading system, shape, cut grade combination you can define 

standard sizes in order to produce planned stones of a pre-defined length 

and width. For each combination you can define multiple standard sizes: 

Advisor allocates the biggest among them. 

When Standard Size Planning is enabled Advisor generates two plans: the 

regular (best possible) and the biggest among the pre-defined standard 

sizes. The Results tab then displays the results. 

The standard sizes are measured in terms of width and length and the unit 

of measure is millimeters. For each width and length you can specify either 

an accurate value or a range of possible values. Advisor always performs 

the most economic allocation possible within the constraints of the 

standard sizes, as you have defined them. 

 To define standard sizes: 

1. Select a grading system, shape and a cut grade. 

2. Select the Use Standard Size Planning check box. 

 

This enables the Change Standard Size Planning button. 

NOTE 

It is important to remember that these standard size settings will 

only apply to the specific combination of the currently selected 

grading system, shape and cut grade. 
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3. Click the Change Standard Size Planning button. 

 

 
 

The Standard Size Settings window opens. This window enables you 

to define the range for each measurement parameter that will ensure 

standard size stones. 

4. Click the New button to open a new row. 

5. To set a standard length, enter a range of millimeter values in From 

and To under Length. 

 

If you want to plan a stone of a specific length, enter the same value in 

From and To. For example, enter From = 3 and To = 3 to perform a 

plan that yields a length of 3. If an exact length is not necessary and 

some flexibility is allowed, enter a range in From and To and let 

Advisor find the best length within the range. For example, specifying 

Length From = 2 and To = 3 amounts to instructing Advisor to 

allocate the best possible length between 2 and 3 mm. 

6. Do the same for the Width columns. 

 

To ensure greater flexibility, you can define multiple standard sizes. 

7. Click the New button again, enter values, and repeat this step as 

many times as the number of sizes you want to define. 

 

In each plan, Advisor will try to allocate the biggest possible standard 

length and width. 

8. To perform plans as economical as possible, in the check box  

Don’t show allocations that lose more than enter a percentage. 

 

if the difference between the maximum standard size and the 

maximum plan is more than the specified percentage, Advisor does no 

perform the standard size planning and performs only the regular plan. 

9. Click Close. 

 To change the settings: 

 Click the Use standard size settings button enabling you to change 

the values. 
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 To remove a standard size definition: 

 Click anywhere on the row you want to delete and then click the 

Delete button. 

 To disable standard size planning: 

You can disable this function without deleting the standard sizes. 

 Clear the Use standard size settings checkbox.  

 

Selecting it again reactivates the standard size planning. 

Current Proportions Status 

Advisor checks the parameters and displays OK if the current proportions 

are workable. 

Column Description 

Parameter Stone parameter 

Allowed Range Minimum and Maximum parameter limits 

User Minimum and 
maximum 

These are your values for creating your own range of 
proportions. You specify a range to instruct Advisor to 
set a certain property to any value within the range, 

when planning a stone. The values you record here 
must fall within the ranges indicated in the Allowed 
Range column. For example, entering a range of 10-50 
for Crown Height means that the crown of a stone 
allocated under this “institute” will never be lower than 
10 and higher than 50. This applies to automatic 

planning; you can always use the Calculate module to 
fine-tune the planning. 

Actual Minimum and 

Maximum 

These are the derived values that Advisor suggests is 

the best range for different parameters, based on the 
values you record in User Values. For example, after 
recording the Girdle range, Advisor automatically 
suggests the best range for Total Depth. You do not 
have to accept the suggested ranges. 

Field Description 

This a textual description of the selected parameter 

Graphic Description 

A graphical display of the selected parameters. 

Girdle Thickness Parameter 

This feature is used for toggling the girdle thickness definition between 

Mountain (final polished stone) and Valley (8-cut).  
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 To toggle the girdle thickness definition: 

1. When available, right-click the Girdle Thickness parameter. 

 

 
 

The popup menu opens. 

2. Choose the unchecked value to toggle the girdle thickness definition. 

 

This is not available on all shapes. 

Building a Set of Proportions 

 To build a new set of proportions: 

1. In the Grading System pane, click the New button. 

 

 
 

The New Grading System window opens. 

2. Enter a name for the new grading system. 

3. In the Shape pane, select the shape for which you want to define the 

proportions. 

4. In the Cut Grades pane, click the Add button to add a new grade.  

 

Advisor initially assigns the default name Cut Grade 0, and when you 

add a new cut grade Advisor automatically adds a new cut grade with a 

value of Cut Grade 1.  

5. If you want to change the default name do the following: 

a) Right-click the name you want to change and choose Rename. 

 

 
 

The Rename Cut Grade window opens. 

b) Enter a new name and then click OK. 

 

You can repeat the Add operation in order to add all grades, 

before you move to the next step. Before you proceed to User 

Values, make sure a grade is selected (the values apply to the 

selected grade). Advisor saves all data as you enter it. 
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6. In Price Factor type a percentage for the selected grade.  

7. Click the Min. and Max. (Minimum and Maximum) boxes in the User 

Values table, and type your ranges. The values you enter refer to the 

shape and cut grade that are currently selected in the upper panes.  

 

Before you enter your values, make sure that the correct shape and 

grade are selected. 

8. After filling the table, add another cut grade (or select one if you have 

defined them), make sure it is selected, and type in its ranges in User 

Values. Repeat this step for all cut grades. 

9. After filling in the proportion ranges for all cut grades, select another 

shape, add its cut grades, and then repeat steps 4 to 9 for all cut 

grades.  

10. Repeat this step for all shapes. 

 To build a set of proportions by copying an existing one: 

1. Select a combination of a grading system, shape and a cut grade. 

2. Click the Copy button (in the Grading System Pane). 

 

The Name New Cut Grade window opens. 

3. Enter a name for the new cut grade 

4. Click OK. 

 

A new set is created with the copied values. 

5. Change the values as needed. 

Auto Sequences 
An auto-sequence is a series of Advisor actions that you can execute in a 

given sequence with a single mouse click or using the special Advisor 

keypad. 

 To open the Sequence Editor: 

 

1. Right-click the Plan tab toolbar (the cursor is pointing to the toolbar). 

 

 
 

The popup menu opens. 

 

The Show/Hide sequences bar option shows or hides the Sequence 

controls on the toolbar. 
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2. Choose Edit sequences. 

 

 
 

The Sequence Editor window opens showing the Special Keyboard 

sequence and Allocation Settings panes. 

 

The table below describes the Sequence Editor fields: 

Field or Button Description 

Select Auto 

Sequence 

Enter the name of the Auto Sequence you want to 

display. 

Show in Toolbar When checked the Sequence numbers are displayed 

in the toolbar 

Display Sequence 

Toolbar 

When checked the Auto Sequence toolbar is 

displayed on the Plan tab 

Delete Deletes the selected Auto Sequence 

Available Actions Lists the available sequences (Macros) 

Add Adds an action to the sequence 

Remove Deletes the selected action from the sequence list 

Wait Adds a wait action to force operator intervention 

Move Up/Down 

Keys 

Used for changing the position of an action in the 

sequence list 

Planning Settings Enables you to choose an institute, shape, grade and 

a template. 

Enter Name for 
new sequence 

Enter the name when creating a new sequence 

Create When a new sequence name is entered this button 
creates a new sequence 

Show Special Keys Opens the Special Keyboard Sequence window 
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A list of all the possible actions is listed in the Available Actions box. 

Each action corresponds to selecting one or more elements on the Advisor 

windows: 

Actions that have a “+ Wait” suffix mean that user intervention is needed 

to complete the action and perform the next action in the sequence. For 

example, to create and position a saw plane you will use the action Editing 

New Saw Plane + Wait. This is equivalent to clicking the Plan tab and 

clicking the New Saw Plane icon. When you execute this action, Advisor 

creates the saw plane and waits for the user to position it on the rough 

stone. 

 To create an auto-sequence: 

1. In the Enter Name for New Sequence field, enter a name for the 

sequence you want to build. 

2. Click the Create button. 

 

The Sequence pane is reset and any actions listed there are deleted. 

3. In Available Actions, click an action and then click the Add button. 

 

The action moves to the right-hand Sequence pane. When you run an 

auto-sequence the commands listed in the right-hand pane are 

executed in sequence, one after the other in the exact order they 

appear in the list. 

 

You can remove an action from the Sequence pane by selecting it on 

the right and clicking the Remove button. 

 

Use the Move Up and Move Down buttons to change the position of 

individual Action Sequences as this is the order in which they will be 

executed. 

4. Some actions, when selected, enable additional parameters in the 

Allocation Settings pane. 

 

Application Settings – when selected perform the planning using the 

grading system, shape and cut grade (or program) settings currently 

selected in the Planning Part A and B pane. 

 

Other – when selected enables you to use different settings to those 

displayed in the Planning Part A and B pane. Selecting Other 

enables the Grading System, Shape, Grade and Template drop-

down selection boxes for you to change the settings. 

5. Check the Show in toolbar button if you want the sequence controls 

displayed on the toolbar. 

 

The Sequence Controls displayed on the toolbar are in the form of 

numbered buttons, one for each sequence, when the Show in toolbar 

button checkbox has been selected. If you have a large number of 

sequences, and you do not use all of them frequently, you may choose 

to make only some of them available on the toolbar, by selecting their 

Show in toolbar button box. Clearing the box, removes the current 

sequence from the toolbar. 

6. Click the Save & Close button. 
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 To assign an auto-sequence to the Advisor keypad: 

1. Click the Show Special Keys button. 

 

 
 

The window expands to show a representation of the auto-sequence 

buttons of the special keypad. 

2. Ensure that the Enable keypad auto-sequence buttons box is 

selected. 

 

If this box is cleared, the auto-sequence buttons on the keypad will not 

work even if they have auto-sequences assigned to them. 

3. For each button, select an auto-sequence from the list below the 

button number. 

 

You can use the Hide Special Keys button to close the extended 

section. 

 To run an auto-sequence from the Advisor screen: 

1. The sequences are displayed as sequence numbers in the Plan tab 

toolbar. 

 

 
 

The buttons show the sequence number. When the mouse hovers over 

a sequence button the sequence name is displayed as a tool tip. 

2. Click a sequence button to execute the corresponding sequence. 

 

While running the sequence, click the Stop  button to stop 

execution. Advisor finishes executing the current action and does not 

execute the subsequent ones. 

 

After the sequence stops as a result of a “+ Wait” action, use the 

Resume  button to resume execution of the sequence. 
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 To run an auto-sequence from the Advisor keypad: 

 Press the required button. 

 To modify an auto-sequence: 

1. In the Auto Sequences Editor dialog box, open the Select Auto 

Sequence drop-down list, and select the sequence you want to 

modify. 

2. Add or remove actions and use the other functions, as necessary. 

3. Click Save & Close. 

Customizing the Toolbar 
The toolbar displays the buttons depending on the selected tab. You can 

customize the toolbar using the toolbar customization window and remove 

a button from the toolbar by pressing the Shift key on the keyboard and 

dragging the button off the toolbar. 

 

 

Advisor enables you to customize the toolbar to display only the required 

functions. 

 To customize the toolbar: 

1. Click the Tools menu. 

 

 

2. Choose Customize from the menu. 
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3. Select a button from the Available toolbar buttons pane and then 

click Add (or double-click the button’s name) to add it to the Current 

toolbar buttons pane. 

OR 

 

Select a button in the Current toolbar buttons pane and the click 

Remove (or double-click the button’s name) to delete it.  

 

The Reset button returns the toolbar to the factory default. 

Show/Hide Toolbar Text 

Advisor can add a text description underneath each toolbar button. This is 

very helpful when you start using this version of Advisor. As soon as you 

are familiar with the different buttons you can hide the text descriptions to 

reduce toolbar clutter. 

 To Show/Hide the toolbar text descriptions: 

1. Click the Tools menu. 

 

 

2. Choose Show/Hide Text from the menu. 
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CREATING AND EDITING VIEWS, REPORTS AND 

LABELS 

Advisor enables you to create views, report and label structures of your 

own. You can create a view that displays, side-by-side, a 3D picture of the 

stone together with its dimensions table. Before you start creating your 

own new views and reports, we suggest that you would find it a lot easier 

to load a built-in view from the Advisor library and then customize it to 

your needs. You should then save your new customized file under a 

different name in the correct display, report or label library, so that you 

can find it again at a later date.  

Opening the Views/Reports Editor 

 To open the editor: 

 On the Tools menu, click Views/Reports Editor. 

 

 
 

The Reports Editor opens displaying last display viewed in Advisor. 

Objects Table 

Object Description 

 
Use the Text object to display static and dynamic text.  
To enter static text, type it directly into the frame. To enter data field text, 
double-click the frame and select grading system fields. You can do the 
same in the Text property as well. 

 
Use the Line object to draw a straight line at any angle. 

 
Enables you to insert pictures (Graphic Image) in the structure. 

  
Use the 3D/Video Dual viewer object to display a 3D view of the 

gemstone OR to the captured video of the gemstone. 

 
Use the Photorealistic View object to display a photo-realistic view of 

the gemstone. 

 
Use the Table object to create tables and report structures. As soon as 

you release the mouse button, after creating the object in the work area, 
the Select No. of Rows and Columns dialog box opens automatically. 
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Creating a New Structure 

 To create a new structure: 

1. Click the New  button to start a new structure. 

2. In the Page Size list box, select one of the following: 

Page Definition Description 

Page Size Select a Page size 

ADDRESS For labels 

A4 For views 

3. Select the page orientation. 

Page orientation Description 

Landscape For views and labels 

Portrait For reports 

This option spreads the structure across the entire work area. 

4. First select an object on the toolbar.  

5. Point anywhere in the work area of the screen and drag the mouse to 

draw the object or container. 

6. Use the object Properties listed in the lower left-hand pane to 

configure the object. 

NOTE 

If you need help in understanding how to use the Properties pane 

see How to Create and Edit the Structures  on page 41. 

7. Repeat the steps to draw and configure the objects you want to include 

in this structure. 

8. Click the Save  button to save. 

 

This opens the Save dialog box. 

9. Click the   button to open the File Type list box. 

 

 

 Select a file type. 

1. In the File Name field box, enter a name for the structure. 

2. Click Save. 
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Opening a Saved Structure File to Edit  

Before you can customize a structure you must first load it into the 

View/Reports Editor.  

 To open a specific structure file: 

1. On the Tools menu, click Views/Reports Editor. 

 

The Reports Editor opens displaying the last structure created. 

2. Click the Open  button. 

3. Click the   button to open the File Type list box. 

 

 

4. Select a file name to insert it into the File Name field box. 

5. Click Open. 

How to Create and Edit the Structures  

This section describes in DETAIL how to use each object to create and edit 

your own customized structures.  

Object Go to Section Page 

 
Creating or Editing Line Objects  42 

 
Creating or Editing Image Objects  43 

 
Creating or Editing 3D Diagram Objects  45 

 Creating or Editing Photorealistic View Objects  47 

 Creating or Editing Table Objects 48 

 Creating or Editing Cell Objects 53 

 
Creating or Editing Text Objects  51 

 Creating or Editing Multiple or Grouped Objects 56 
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Creating or Editing Line Objects 

The line is a graphic element that can also be used as a divider between 

objects  

 To create or edit a line object: 

1. Either ensure that the line you want to edit is displayed in the 

Views/Reports Editor. 

OR 

Click the Line  button located on the toolbar. 

2. Left-click and hold anywhere in the work area to start the line, and 

then drag the mouse to create the line. 

3. Release the mouse when the line is the required length. 

 

 
 

It should now look something like this. 

Using the mouse, the line can be shortened, lengthened and moved 

anywhere in the work area. You can also change the angle of the line. 

Line Properties Table 

Properties Description 

Color Changes the object color. See Changing the Color below. 

Name Changes the name in the properties table.  

Style Dashed or Solid. 

Thickness Determines the thickness of the line. 

X1 Start of line on the X-axis. 

X2 End of line on the X-axis. 

Y1 Start of line on the Y-axis. 

Y2 End of line on the Y-axis. 

4. Click the   field, and type a name for the line object, or leave the 

default name. 

5. If you have changed the name of the line object, click the line object. 

 

The new name is now displayed in the Properties list box. 

6. Click the   field, and then click the  button to open the list box. 



Advisor - Administrator Guide Creating and Editing Views, Reports and Labels 

 

©Sarin Technologies Ltd. 2000-2006. All rights reserved. 43 

7. Select Solid or Dashed. 

8. Click the   field 

 

See Changing the Color on page 59 for detailed instructions. 

 

 
 

In this example we have created a dashed blue line. 

9. Apply the properties of Thickness or change the X and Y values 

manually if required, as described in the Line Properties Table. 

10. Go to Saving the Reports, Views and Labels on page 60. 

Creating or Editing Image Objects 

 To create or edit image objects: 

1. Ensure that the image you want to edit is displayed in the 

Views/Reports Editor. 

OR 

Click the Image   button located on the toolbar. 

2. Left-click and hold anywhere in the work area to start the image 

container, and then drag the mouse to resize it. 

3. Release the mouse when the image container is the required size. 

 

 
 

The image container is now displayed in the work area. Using the 

mouse, the container can be shortened, lengthened and moved 

anywhere in the work area.  

4. Click the   field, and type a new name for the image object, or 

leave the default name. 

5. If you have changed the name of the image object, click the image 

object. 

 

The new name is now displayed in the Properties list box. 
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Image Properties Table 

Properties Description 

AllowDistortion Permits you to change the image aspect ratio when 
inserting an image into a container of a different size. 
Logos’ aspect ratio should NOT be changed. 

Border Determines if there is to be a border or not. 

BorderColor Changes the border color.  
See Changing the Color below. 

BorderWidth Determines the width of the border. 

FileName Click this field to select the image file you want to insert 

inside the container. 

Height The actual height of the container. 

Left Distance from the left side of the work area to the left-

hand side of the container. 

Name Enter a name for this image. 

Top Distance from the top of the work area to the top of the 
container. 

Width The actual width of the container. 

6. Click the   field. 

 

 

7. Click the Browse   button. 

 

 
 

The Select file dialog box opens. 

8. Navigate to the required folder and select an image file for insertion. 

9. If you want a border, click the   field, and then click the  

button to open the list box. 

10. Select Flat. 

11. If you have decided to have a border, click the   field 

 

See Changing the Color on page 59 for detailed instructions. 
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12. Ensure that the  property is NO. 

 

You do not normally want the image or logo to lose its aspect ratio and 

look distorted. 

 

 

13. Right-click the image. 

 

 

14. Click Shrink to Contents. 

 

 
The container has now shrunk to the size of the image. 

15. Apply the properties of Height, Top, Width and Left manually if 

required, as described in the Image Properties Table. 

16. Go to Saving the Reports, Views and Labels on page 60. 

Creating or Editing 3D Diagram Objects 
This object is for displaying a 3D view in the Data tab work area. 

 To create or edit 3D/Video dual objects: 

1. Ensure that the 3D/Video object you want to edit is displayed in the 

Views/Reports Editor. 

OR 

Click the 3D Diagram button located on the toolbar. 

2. Left-click and hold anywhere in the work area to start the 3D/Video 

object, and then drag the mouse to resize it. 
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3. Release the mouse when the 3D object is the required size. 

 

 
 

The 3D/Video object is now displayed in the work area. 

4. Click the   field, and type a new name for the 3D/Video object, 

or leave the default name. 

5. If you have changed the name of the 3D/Video object, click the 

3D/Video object. 

 

The new name is now displayed in the Properties list box. 

3D Diagram Properties Table 

Properties Description 

BGColor The 3d Diagram can be given a background color.  
See Changing the Color below. 

BorderColor Changes the border color. See Changing the Color below. 

BorderWidth Determines the width of the border. 

Height The actual height of the container. 

Left Distance from the left side of the work area to the left-
hand side of the container. 

Name Enter a name for this 3D/video object. 

Top Distance from the top of the work area to the top of the 
container. 

View The choices are 3D, Video and Both. Determines which 
object is displayed. 

Width The actual width of the container. 

6. If you want a border, click the   field, and then click the  

button to open the list box. 

7. Select Flat. 

8. If you have decided to have a border, click the   field 

 

See Changing the Color on page 59 for detailed instructions. 

9. Apply any of the other properties manually if required, as described in 

the 3D Diagram Properties Table. 

 

It is recommended to leave the other default values as is and only 

change them if necessary at a later time. 

10. Go to Saving the Reports, Views and Labels on page 60. 
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Creating or Editing Photorealistic View Objects 

This object is for displaying a Photorealistic object in the Data tab work 

area. 

 To create or edit Photorealistic objects: 

1. Ensure that the Photorealistic object you want to edit is displayed in 

the Views/Reports Editor. 

OR 

Click the Photorealistic   button located on the toolbar. 

2. Left-click and hold anywhere in the work area to start the 

photorealistic object, and then drag the mouse to resize it. 

3. Release the mouse when the photorealistic object is the required size. 

 

 
 

The Photorealistic viewer is now displayed in the work area. 

Photorealistic Properties Table 

Properties Description 

BGColor The 3d Diagram can be given a background color.  
See Changing the Color below. 

Border Determines if there is to be a border or not. 

BorderColor Changes the border color.  
See Changing the Color below. 

BorderWidth Determines the width of the border. 

Height The actual height of the container. 

Left Distance from the left side of the work area to the left-
hand side of the container. 

Lighting This feature enables you to choose from a long list of 
different lighting schemes to give the special photorealistic 

affect of the stone. 

Name Enter a name for this photorealistic viewer. 

Top Distance from the top of the work area to the top of the 
container. 

View The choices are Top, Bottom Side Table Up, and Side 
Table Down. 

Width The actual width of the container. 

4. Click the   field, and type a name for the photorealistic viewer, or 

leave the default name. 
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5. If you have changed the name of the photorealistic viewer, click the 

photorealistic viewer. 

 

The new name is now displayed in the Properties list box. 

6. Click the   field, and then click the  button to open the lighting 

scheme list box. 

7. Select a lighting scheme. 

8. If you want a border, click the   field, and then click the  

button to open the list box 

9. Select Flat. 

10. If you have decided to have a border, click the   field 

 

See Changing the Color on page 59 for detailed instructions. 

11. Apply any of the other properties manually if required, as described in 

the Photorealistic Properties Table. 

12. Go to Saving the Reports, Views and Labels on page 60. 

Creating or Editing Text Objects 

This object is for displaying a Text object in the Data tab work area. 

 To create or edit Text objects: 

1. Ensure that the Text object you want to edit is displayed in the 

Views/Reports Editor. 

OR 

Click the Text   button located on the toolbar. 

2. Left-click and hold anywhere in the work area to start the text object, 

and then drag the mouse to resize it. 

3. Release the mouse when the Text object is the required size. 

 

 
 

The Text object is now displayed in the work area. 

4. Click the   field, and type a name for the text object, or leave the 

default name. 

5. If you have changed the name of the text object, click the text object. 

 

The new name is now displayed in the Properties list box. 
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6. If you want a border, click the  field, and then click the  button 

to open the list box. 

7. Select Flat.  

8. If you have decided to have a border, click the   field 

 

See Changing the Color on page 59 for detailed instructions. 

Text Properties Table 

Properties Description 

BGColor The Table object can be given a background color. 
See Changing the Color below. 

Border Determines if there is to be a border or not. 

BorderColor Changes the border color. 

BorderWidth Determines the width of the border. 

Font You can choose any font that is installed on your 
computer. This font will apply to all table cells. 

Height The actual height of the table. It can only be changed 
when the whole table is selected. 

Left Distance from the left side of the work area to the left-
hand side of the table.  

Only when the whole table is selected, can this field be 
seen or changed. 

LinkAction This link can either be Viewed or Printed.  

LinkName Shows the path of the link for the text box. 

MultipleRows When Yes the text will wrap around the text box. When 
No, part of the text may not be visible. 

Name Enter a name for this table to be displayed in the 
properties table. 

ReadOnly If Yes you cannot change the information displayed. If 
No you can change the value in the Advisor display. 

Text This field is for inserting free text into the text box, or 
selecting a substitution field. These are dynamic fields 
that are automatically inserted depending on what is 
currently being viewed in the Data tab. 

TextAlignment You can align the text Left, Right or center. 

ToolTip Enter here a Tool Tip for each text box. 

Top Distance from the top of the work area to the top of 
the table. 
Only when the whole table is selected, can this field be 
seen or changed. 

Transparent The options are Yes and No. 

Width The actual width of the container. 
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9. If you want the table to be transparent (no background), click the 

 field and select Yes. 

10. Click the  field and click the  button. 

 

 
 

The Font dialog box opens. These are the fonts installed on your 

computer. 

11. Select a Font, a Font style and font Size. 

 

This selection is only for the selected cell unless the whole table is 

selected. 

12. Double-click the text box. 

OR 

 

Click the   field and then click the Browse  button. 

 

 

13. Select a Field (Text Substitution Field). 

14. Click OK. 

15. Click the  field and type a ToolTip for the text box. 

16. Apply any of the other properties manually if required, as described in 

the Text Properties Table above. 

17. Go to Saving the Reports, Views and Labels on page 60. 
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Creating or Editing Table Objects 

This object is used for displaying a Table object in the Data tab work area. 

See also Creating or Editing Cell Objects on page 53 for editing the table 

cells.  

There are dynamic right-click menus created to assist you.  

 To create or edit Table objects: 

1. Ensure that the table object you want to edit is displayed in the 

Views/Reports Editor. 

OR 

Click the Table   button located on the toolbar. 

2. Left-click and hold anywhere in the work area to start the table object, 

and then drag the mouse to size it. 

3. Release the mouse when the Table is the required size. 

 

 
 

The Table Creator dialog box is now displayed in the work area. 

4. Select a value for the Number of columns and the Number of 

Rows. 

 

Click the  buttons to increase the value or overwrite the value 

displayed. 

5. Click OK. 

 

 

6. If you inadvertently select a table cell and want to re-select the whole 

table, do the following.  

a) Drag a container around the table to select the whole table. 

OR 

 

Select the table by its name from the properties’ list-box. 

b) From the pop-up menu, click Select All. 
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Table Properties Table 

Properties Description 

BGColor The table can be given a background color. See 
Changing the Color below. 

Border Determines if there is to be a border or not. 

BorderColor Changes the border color.  

See Changing the Color below. 

BorderWidth Determines the width of the border. 

Font You can choose any font that is installed on your 

computer. 

Height The actual height of the table. It can only be changed 

when the whole table is selected. 

Left Distance from the left side of the work area to the left-

hand side of the table.  
Only when the whole table is selected, can this field be 
seen or changed. 

Name Enter a name for this table to be displayed in the 

properties table. 

ReadOnly If Yes you cannot change the information displayed. If 

No you may type your own text while viewing this 
table in Advisor. 

Rows Displays the number of rows only when the whole table 
is selected. 

TextAlignment You can align the text Left, Right or Center. 

Top Distance from the top of the work area to the top of 

the container. 
Only when the whole table is selected, can this field be 
seen or changed. 

Transparent The options are Yes and No. 

Width The actual width of the container. 

 

7. You can size the table by dragging on one of the eight handles as 

shown below. 

 

8. Click the   field, and type a name for the table, or leave the 

default name. 

9. If you have changed the name of the table, click the Table object. 

 

The new name is now displayed in the Properties list box. 
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10. If you want a border, click the  field, and then click the  button 

to open the list box 

11. Select Flat. 

12. If you have decided to have a border, click the   field 

 

See Changing the Color on page 59 for detailed instructions. 

13. Click the  field and click the  button. 

 

 
 

The Font dialog box opens. These are the fonts installed on your 

computer. 

14. Select a Font, a Font style and font Size for the whole table. 

15. If you want the table to be transparent (no background), click the 

 field and select Yes. 

16. Apply any of the other properties manually if required, as described in 

the Table Properties Table. 

17. Go to Saving the Reports, Views and Labels on page 60. 

Creating or Editing Cell Objects 

This object is for displaying a cell object in the Data tab work area. 

There are dynamic right-click menus created to assist you.  

 To create or edit cell objects: 

1. Ensure that the table object you want to edit is displayed in the 

Views/Reports Editor. See Creating or Editing Table Objects above 

for creating a table.  

2. Select a cell by clicking on it. 
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Cells Properties Table 

Properties Description 

BGColor The cell can be given a background color. See 
Changing the Color below. 

Border Determines if there is to be a border or not. 

BorderColor Changes the border color. 

BorderWidth Determines the width of the border. 

Font You can choose any font that is installed on your 

computer. 

Height The actual height of the table. It can only be changed 

when the whole table is selected. 

Left Distance from the left side of the work area to the left-

hand side of the table.  
Only when the whole table is selected, can this field be 
seen or changed. 

LinkAction This link can either be Viewed or Printed.  

LinkName Shows the path of the link for the cell. 

MultipleRows When Yes the text will wrap around the text box. 
When No, part of the text may not be visible. 

Name Enter a name for this table to be displayed in the 
properties table. 

ReadOnly If Yes you cannot change the information displayed. If 

No you may type your own text while viewing this cell 
in Advisor. 

Text This field is for inserting free text into the cell, or 
selecting a data field. These are dynamic values that 

are automatically inserted depending on what is 
currently being viewed in the Data tab. 

TextAlignment You can align the text Left, Right or Center. 

ToolTip Enter here a Tool Tip for each individual cell. This Tool 

Tip will be displayed for a few seconds when placing 
the mouse cursor over the cell. 

Transparent The options are Yes and No. 

Width The actual width of the cell. You can drag the sides of 
the cell to make it wider or narrower. 

3. Click the   field, and type a name for the cell, or leave the default 

name. 

4. If you have changed the name of the cell, click the Cell object. 

 

The new name is now displayed in the Properties list box. 
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5. You can enter text data directly into a single cell or into multiple cells 

by typing the data into the Text field located in the properties table. 

 

To select multiple cells use the Ctrl key and click one cell after 

another, or use the Shift key to select a range of contiguous cells. To 

do this first click the first cell, press the Shift key continuously, and 

then click the last cell in the range. 

6. Double-click a cell to enter a data field. 

OR 

Click the   field and then click the Browse  button. 

 

 

7. Select a Field (Text Substitution Field). 

8. Click OK. 

9. If you want a border, click the  field, and then click the  button 

to open the list box. 

10. Select Flat.  

11. If you have decided to have a border, click the   field 

 

See Changing the Color on page 59 for detailed instructions. 

12. If you want the cell to be transparent (no background), click the 

 field and select Yes. 

13. Click the  field and type a ToolTip. 

 

This ToolTip is only for the selected cell. 
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14. Click the  field and click the  button. 

 

 
 

The Font dialog box opens. 

15. Select a Font, a Font style and font Size. 

 

This selection is only for the selected cell unless the whole table is 

selected. 

16. Apply any of the other properties manually if required, as described in 

the Cells Properties Table. 

17. Go to Saving the Reports, Views and Labels on page 60. 

Creating or Editing Multiple or Grouped Objects 
This section describes in detail on how to manage grouped or multiple 

objects.  

 To create or edit multiple objects: 

1. Ensure that the objects you want to edit are displayed in the 

Views/Reports Editor. 

OR 

 

Click any of the object buttons located on the toolbar and create 

multiple new objects.  

See the above sections for creating the individual objects.  

NOTE 

We strongly recommend that you follow our example step-by-

step as described below, before rushing off to create your own 

multiple group objects from scratch. 

2. On the Toolbar, click the   button to load the group object.  
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3. Open a display from the list. 

 

 

NOTE 

Please note that the Properties table is empty and the arrow 

cursor at the bottom of the window shows that the Group Object 

toolbar is disabled. This is because a group (more than one 

object) is not yet selected. 

Multiple or Grouped Objects’ Properties 

Multiple objects display their shared properties in the properties list. 

Those properties which are set to identical values will display their 

values. Others will display only the property name. You can type a 

value for these properties which will be set for all the multiple selected 

objects. 

4. From the Edit menu, click Select All.  

OR 

 

 
 

Press the Ctrl+ A keyboard keys to select all the objects displayed in 

the work area.  
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The Multiple Objects properties are now displayed and the Multiple 

Objects toolbar is now enabled. When the value for a specific property 

is not displayed, it means that all the selected objects do not have the 

same value. 

5. You can manipulate the objects as a group using the Group Objects 

Toolbar buttons. The individual buttons are described in the table 

below. 

Group Object Toolbar Table 

Button Description 

 Make same width 

 Make same height 

 Make same size 

 Align left 

 Align right 

 Align top 

 Align bottom 

 Evenly space the controls horizontally 

 
Evenly space the controls vertically 

 Align center 

 Align middle 

Example of Align Left 

Before: 

 

6. Select all the objects using the mouse, Select All from the Edit menu 

or using the keyboard keys Ctrl+A, or click the individual objects you 

wish to select holding down the Shift or Ctrl keys. 
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7. From the Group Objects toolbar, click the Align Left  .button. 

 
The result should look something like this. 

8. Go to Saving the Reports, Views and Labels on page 60. 

Changing the Color 

 To change the color: 

1. Click the object to select it. 

2. In the Properties pane, click the Color field. This field can have other 

names, namely, BorderColor. 

 

 
 

The Color field change button is now displayed. 

3. Click the Change Color  button to open the Color Palette dialog. 
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4. Select a color or click the   button. 

 

 
 

Define a custom color using the slider arrows at the top and right-hand 

side of the dialog box, or by typing the values into the boxes. 

5. When you have selected a custom color, click the  

button. 

 

The selected custom color is now saved for future use. You can see 

then in the Custom Color frame. 

6. Click OK. 

 

The information is transferred to the object and the dialog box closes. 

Saving the Reports, Views and Labels 

This section describes how to save the files you have just created. 

NOTE 

It is extremely important to regularly make a backup copy of your 

library. 

 

 To save reports, views and labels: 

1. On the File menu, click Save As… 

 

 

2. Choose the correct file library. 

3. Enter a unique file name, or overwrite an old one. 

4. Click Save. 
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Appendix A Dimensions in the Rough 
Stone 

 

Dimensions Description 

UG Distance between the center of the polished result upper girdle 

and the highest point of the rough stone surface. 

LG Distance between the center of the polished result lower girdle 

and the lowest point of the rough stone surface. 

TL Distance between the center of the polished result table and the 

highest point of the rough stone surface. 

CL Distance between the center of the polished result culet and the 

lowest point of the rough stone surface. 

 

 


